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Reports

Built-in Reports

Category List
To print a list of the Categories you have set up:
➢ At the main CatBase screen, choose Categories from the Data menu, or

click on the Categories button in the CatBase Options palette.
➢ Click on All Records when the Search Dialogue window appears.
A window opens up, displaying a list of all your Level One categories. At the

bottom of the window there’s a button labelled Print Hierarchy.
➢ Click on the Print Hierarchy button.
The following dialogue box appears:

You can print the report or you can save it to disk as a text file. If you save it
to a file, you’ll be able to open it up with a word processor or page layout pro-
gram and format it any way you like.

Printer
To print the Category list:

➢ Make sure the Printer radio button is selected

➢ Click on OK.
The report will be printed. The categories are sorted alphabetically, with the

Level 2 categories listed under their related Level 1 category, and the Level 3 cat-
egories listed under their related Level 2 category. If you had categories entered
at all three levels, your report might look something like this:
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If you don’t like this layout, print the report to an ASCII (plain text) file instead.
Then you can open it up in a word processor or page layout program and modify
it in any way you like.

Text File
To print the Category report to a text file:
➢ Click on the ASCII File radio button.
➢ Click on OK.
You will be prompted to enter a name for the disk file that will be created.
✏ Enter a name.
➢ Click on Save.
CatBase creates the file and lets you know when it is finished.

Export Style Sheet Reference
You might find it useful to print out a reference to your Export Style Sheets.

This shows how an Export Style Sheet is set up — the paragraphs that comprise
it, how they are formatted, and what Elements they contain. 

To print out an Export Style Sheet Reference:
➢ At the main CatBase screen, choose Export Style Sheets … from the

Data menu.
➢ Find the Export Style sheet or Sheets that you want to print out.
➢ Choose Print Reference from the File menu
The references are printed.
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Quick Reports
In addition to CatBase’s built-in report formats, the Quick Report editor

makes it possible for you to quickly and easily produce columnar reports of
your own design. In a columnar report, each column represents one item of data
(usually a field from the database), and there is one row for each record, plus
additional rows for headers, footers breaks, and totals. If you are accustomed
to working with spreadsheets, the idea of rows and columns will be familiar to
you. The intersection of a row and column is called a cell; a cell is where the
data is actually displayed.

The Quick Report Editor enables you to:
• Create break areas
• Set column widths or let the program figure them for you based on the

size of the data to be included
• Choose the fonts and styles to be used
• Compute summary calculations
• Sort on as many fields as you have break levels

You can create a Quick Report any time you have a list of records displayed
on your screen,  and Quick Reports that you design can be saved so that they
can be used again. 

Quick Report Basics
This section describes basic operations used when working with the Quick

Report editor to design a report.

Creating a New Quick Report
To design a quick report:
➢ With a list of records on your screen, choose Quick Report  from the

File menu.
CatBase displays the Quick Report editor. If an existing report design is dis-

played, choose New from the File menu to begin a new Quick Report design.

Loading and Saving a Quick Report Design
You can save a quick report design as a file that you can open from the

Quick Report editor. The quick report design includes all of your specifications
for the report, but not the data. By saving report designs, you can maintain a
library of quick report designs that you can use depend-ing on your needs.

Note: If you do not save your design, it is displayed the next time you open
the Quick Report editor in that worksession only.

To save a quick report design:
➢ Choose Save from the File menu.
CatBase displays a create-file dialogue box in which you can name the quick

report design.
Note: Quick report files on Windows are denoted by the file extension .4QR.
➢ Enter a filename for the quick report and click OK.
CatBase saves the report as a file that you can open with the Quick Report

editor. You can save the file on any available hard disk.
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Saving a previously saved or loaded report replaces the old report.

Loading a Quick Report Design
When the Quick Report editor is open, you can load a saved design and use it

to print a new report. You can use the same quick report design repeatedly to
print different selections of records.

To load a report design:
➢ Choose Open from the File menu.
CatBase displays an open-file dialogue box displaying a list of available quick

report designs.
➢ Double-click a filename or select a filename from the list and click OK.
CatBase replaces the current report design with the design you opened.

The Quick Report Editor
When you create a quick report, you can specify the following:
• Columns that display fields or formulas
• Sort levels and order
• Break levels
• Summary calculations
• Text for labels
• Formats for numeric and Boolean data
• Font, font size, style, and justification for labels, summary calculations, and

data
• Page headers and footers
The following illustration shows the major elements of the Quick Report editor:

The Quick Report editor contains the following elements:
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Fields list 
This list displays fields in the current table. 

Sort List
This list displays the sort order assigned to the report and indicates whether each
sort level is ascending or descending. If your report will contain summary calcu-
lations from groups of records, you must sort the current selection on one or
more fields.

Note: You can change the order of fields in the Sort list by dragging the field
name vertically to the desired position in the list.

Quick Report area
You use this area to design the report by dragging fields, adding formulas,

adjusting column widths, and adding or deleting breaks.

Summary calculation buttons
You use these buttons to place summary calculations in the Break and Total

areas of the report.

Column properties
You use these check boxes to set the following characteristics for each col-

umn in the report:
• Sorted: Click this check box if you want the records to be sorted on the

selected column.
• Repeated Values: You use this check box to tell the Quick Report editor to

repeat the values in a Break column. If you do not select the Repeated
Values check box, each Break value is displayed only once.

• Automatic Width: Click this check box to request that the Quick Report
editor compute the width of the selected column based on the maximum
length of the contents of the column. The sizing is done only at the time
the report is printed. You can check this option for each column individu-
ally. The check box does not refer to the entire report. If the Automatic
Width check box is not checked for a column, you can modify that col-
umn’s width by dragging column dividers.

Column dividers
These lines indicate the boundaries between columns of the report.

Right margin marker
This marker indicates the right margin of the report. The right margin marker is

meaningful only when no columns have the Automatic Width check box selected.
You may have to scroll horizontally to view the right margin marker.

Column header
The column header displays the names of fields or formulas added to the

report.

Row label bar
This bar shows the different areas of the report: the Header, Detail, Break, and

Total rows.

Header row
This row contains information that appears in the printed report above the
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records. The Quick Report editor automatically places field names in the Header
row, but you can modify its contents.

Detail row
This row prints information from individual records and will be repeated in the

printed report for each break.

Break and Totals rows
These rows display summary calculations and any associated labelling. The

Break row displays summary calculations for each subgroup in the report and the
Totals row displays summary calculations obtained from all records in the current
selection.

Cells
A cell is the intersection of a row and a column.

Scroll bars
You use the scroll bars to view parts of the quick report design that extend

beyond the area of the quick report form.

Resizing Areas in the Editor
You can resize the various list and display areas in the Quick Report editor.

Areas that can be resized are bordered by a raised line.
To resize an area in the editor:
1 Move the pointer over the area border to change the pointer into a resizing

pointer or .

2 Drag the border up or down, or left or right to resize the area.

The Quick Report Pop-up Menus
The Quick Report editor has “hidden” pop-up menus that make it easy to

access certain row, column, and cell operations. Instead of making menu selec-
tions or working with the Cell or Column properties areas, you can perform cer-
tain operations by displaying a Quick Report pop-up menu.

There are separate pop-up menus for row, column, and cell operations.

To use a pop-up menu:
1 Position the pointer in a cell, a row label, or a column heading and hold

down the mouse button.
A pop-up menu appears. The commands in the pop-up menu depend on

where your pointer is (i.e., a row label, column heading, or cell). Also, menu com-
mands that are inappropriate for the particular row, column, or cell are disabled.

The following illustrations show the three Quick Report pop-up menus.
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Cells

Rows

Columns
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Working with the Quick Report Editor
This section describes the basic operations that you can perform in the Quick

Report editor.

Selecting Rows, Columns, and Cells
When designing a quick report, you need to select rows, columns, and cells in

the quick report form. A cell is the intersection of a row and a column.
To select a row:
Click on the Header, Detail, Break, or Total markers on the row label bar to the

left of the Quick Report form.
OR
Click in a row to the right of all columns in the Quick Report form.
To select a column:
Click above the Header row of a column.
To select a cell:
Click the cell.

Adding and Modifying Text
You can add or modify text in the quick report form to label parts of the report.

For example, if you requested summary calculations, you can label them by
adding text to other cells in the Break and Total rows.

You can add and modify text as follows:
• Edit the text that CatBase automatically adds to the Header row of the

report
• Insert text in empty cells of the Break and Totals rows
• Insert the value of a Break field in the Break rows
• Specify the font, font size, justification, and style for any text that appears

in the report
Adding Text
To add text in a report cell:
1 Click twice on an empty cell in the quick report form.
A text insertion point appears in the cell.
If you are entering a label for a summary calculation, select a cell in the same

row as the cell containing the calculation icons. You cannot enter text into the
same cell that contains summary calculations.

2 Type the text in the cell.

Modifying Text 
To modify text in a cell:
1 Double-click in a cell to get an insertion point and drag across the text in

the cell you want to modify.
CatBase highlights the selected text.
2 Type the new text in the cell.

Specifying Font Attributes
While designing your quick report, you can specify different fonts, font sizes,

justification, and styles. You can then apply these specifications to text, data, and
summary calculations within rows, columns, or cells in the quick report.

If you assign specifications to the Detail row of the report, you will not see the
results until you preview or print the report.
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You can specify font attributes using either the Quick Report menu commands
or the Quick Report pop-up menu.

To specify font attributes using the Quick Report menus:
1 Select the column, row, or cell where you want to apply the font.
2 Choose a font from the Font menu or choose a font size, style, or justifica-

tion from the Style menu.
CatBase applies the font to any text, data, or summary calculations that

appear in the selected area.
To specify font attributes using the Quick Report pop-up menu:
1 Hold down the mouse button on the row label, column header, or cell to

which you want to apply the font attributes.
A pop-up menu appears.
2 Use the Font, Size, Style, or Alignment hierarchical menus to change the

font attributes as desired.

Adding Columns to the Report
You create columns by dragging field names from the Fields list to the quick

report area.

To add a field:
• Drag the name of a field to the right of existing columns in the Quick

Report area and release the mouse button.
CatBase creates a column for the field and places the field name in both the

column header and the cell in the Header row.
By default, CatBase prints the field names as column heads at the top of each

page in the quick report.

Inserting Columns 
You can insert an empty column in a quick report. After you insert the column

you can assign a field or a formula to the column.
To insert a column:
1 Select a column.
2 Choose Insert Column from the Edit menu.
OR
Hold down the mouse button to display the Quick Report pop-up menu and

choose Insert Column.
CatBase inserts a blank column to the left of the column you selected. To

assign a field to the empty column, drag a field name to it.
To assign a formula to the column, see the section “Adding Formulas to a

Quick Report”.

Deleting Columns
As you specify fields for your quick report, you may want to remove some

columns to place them elsewhere. Or, you might want to delete the column from
the report.

To delete a column using the Quick Report menu bar:
1 Select the column you want to delete.
2 Choose Delete Column from the Edit menu.
CatBase removes the selected column from the quick report form.
To delete a column using the Quick Report pop-up menu:
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1 Hold down the mouse button on the column header.
The Quick Report pop-up menu appears.
2 Choose Delete Column from the pop-up menu.

Replacing Columns
You can replace a column in the quick report by dragging another field over it.

You can also replace a field with a formula.
To replace a column:
1 Drag a field from the Fields list to the column you want to replace.
OR
Select the column you want to replace and choose Edit Column from the Edit

menu.
OR
Hold down the mouse button on the column header to display the Quick

Report pop-up menu and choose Edit Column.
The Formula editor appears.
2 If you displayed the Formula editor, enter a formula for the column.
If you want to assign a field to the column, you can simply use the field name

as the formula.
When you print the quick report, CatBase prints the results of the formula for

each record that appears in the Detail row.
See the section “Adding Formulas to a Quick Report” for information about

adding a formula to a quick report.

Sizing Columns
By default, the Quick Report editor sizes columns automatically (as reflected

in the Automatic Width check box). It sizes each column based on the maximum
length of data displayed in the column and any labels typed into the column. The
Quick Report editor sizes columns at the time the report is printed.

To view the widths of each column, preview the report to the screen.
See “Printing a Quick Report”  for more information about previewing the

report.
Because selecting the Automatic Width check box changes the width of a col-

umn based on the maximum width of data in the records being printed, selecting
different records can change the size of the columns.

You can resize a column manually after deselecting the Automatic Width
check box. When a column is set manually, text in the column wraps within the
specified area.

To manually resize a column:
1 Select the column you want to resize.
2 Deselect Automatic Width. (You can deselect Automatic Width using either

the check box in the Column Properties area or the Quick Report pop-up
menu for that column.)

3 Move the pointer over the column divider in the quick report to change the
pointer into a column width cursor.

4 Drag the column divider to the left or right to resize the column.

Adding Formulas to a Quick Report
You can add a formula to a column in a quick report. For example, you can
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add a formula that computes employees’ monthly salaries from an Annual Salary
field.

To add a formula:
1 Insert an empty column or click an existing column and choose Edit

Column from the Edit menu.
OR
Double-click an existing column.
OR
Hold down the mouse button on an existing column header to display the

Quick Report pop-up menu and choose Edit Column.
CatBase displays the Formula editor, in which you can build a formula. If you

selected an existing column, the formula you create will replace the previous
contents of the column.

Note! Make sure that the formula you create does not change the current
selection of records in the table on which the Quick Report is based. Changing
the current selection will cause problems when you print the quick report since
the report is based on the current selection. 

2 Build the formula.
OR
Click the Load button to retrieve an existing formula from disk.
For information about using the Formula editor, refer to “The Formula Editor”

later in this chapter.
To save the formula as a file that you can retrieve and use in another column

or in another report, click the Save button and enter a filename in the dialog box.
If you click the Load button, CatBase displays an open-file dialogue box and

asks you to select a file. When you load a file, it replaces any formula that cur-
rently appears in the Formula editor. After you load a formula, you can modify it in
the editing area.

3 Click OK to assign the formula to the column.
CatBase adds a new label to the column that identifies it as a formula. You

can relabel the column by typing a label into the header cell for that column.
Formulas are labelled C1 through Cn. The labels are the names of variables

that contain the column’s value. You can use these variables in other formulas.
Click the Cancel button to close the editor and return to the Quick Report

editor without adding the formula.

Sorting Records and Creating Breaks
An important feature of the Quick Report editor is the ability to sort the

records in your report. You sort records for two reasons:
1 To view records in a particular order,
2 To create groups of records and Break areas in the report for the purpose

of reporting summary calculations for groups.
See the section “Setting Break Levels”  for information about summary calcu-

lations.

Specifying a Sort Order
You can specify a sort order at any time. For example, if you wanted to sort
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the Product by the Product Name field, you would select the Product Name col-
umn, and then set the Sorted property.

You can also sort on a formula by selecting the column that contains the for-
mula and then clicking the Sorted check box or choosing Sorted from the Quick
Report pop-up menu for that column. See the section “Adding Formulas to a
Quick Report” for more information about adding formulas to quick reports.

To specify the sort order using the Sorted check box:
1 Select the column that contains the field or formula you want to specify as

the first sort level.
2 Click the Sorted check box.
To specify the sort order by dragging:
• Drag a field from the Fields list to the Sort order list.
If the field is not already in the quick report design, CatBase adds it as the last

field in the design.
To specify a sort order using the Quick Report pop-up menu:
1 Hold down the mouse button on the column header belonging to the col-

umn you want to sort.
The Quick Report pop-up menu appears.
2 Choose Sorted from the pop-up menu.
CatBase displays the name of the field in the Sort list. To the right of the name

is an arrow, indicating an ascending sort order. By default, all sorts are performed
in ascending sort order.

3 If necessary, click the sort direction arrow to sort the column in
descending order.

4 If desired, select additional fields or formula columns and add the Sorted
property using either the Sorted check box or pop-up menu command.

You can specify ascending or descending sort order for any additional fields
or formulas you specify.

When you specify multiple sort levels, CatBase sorts the records on the first
field in the Sort field list, then on other fields in the order that they appear in the
list. 

To change the level of a Sort field:
• Drag the name of a field or formula up or down within the Sort list to the

desired sort level.

Deleting a Field or Formula from the Sort List
You can delete the any field or formula from the Sort list.
To delete a field or formula from the sort order:
• Select the column and deselect the Sorted check box.
OR
Hold down the mouse button on the column header to display the Quick

Report pop-up menu and deselect the Sorted menu command.
CatBase removes the field or formula in the Sort field list. It does not delete

the column itself from the report. When you print the report, CatBase will no
longer use that field or formula to sort the records.

Setting Break Levels
In a quick report, you set break levels to separate or “break” records into
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groups according to values in one or more sort fields. A Break area is printed at
each break level. You can print summary calculations in the Break area. The sum-
mary calculations — sum, average, minimum, maximum, and count — are calcu-
lated for each group of records.

Break levels are determined by the sort levels and Break rows. For example, if
you sort records by Country and create a Break row, CatBase inserts a break
between each group of records that are in the same country.

After you add a Break row to the quick report, you can request summary cal-
culations on each break. For example, you can insert a summary calculation in a
Break row to display subtotals for sales from each county in a marketing region.
Refer to the section “Adding Summary Calculations”  for more information about
adding summary calculations to Break and Total rows.

To insert a Break row:
1 Choose Add Break from the Edit menu.
OR
Hold down the mouse button on the Total row label in the Row label bar and

choose the Duplicate Break menu command.
CatBase adds a Break row. The following figure shows a Break row in a quick

report design.

2 If desired, add additional Break rows by repeating step 1.
There should be at least as many sort levels as break levels.
CatBase adds a sequential number to each new break label in the row label

bar, for example, Break1, Break2, Break3, and so forth.

Using the Values of Break Fields in Labels
You can improve the appearance and comprehensibility of your reports by
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labelling each Break row using the value of the Break field.
To request that the value of a Break field be printed in a label placed in the

Break area, use the number sign (#) in the label. For example, the text “Average
cost for products sold by #” will insert the company name (in this case, the value
of the Company Name field) in place of the number sign when the report is print-
ed.

The number sign does not need to be placed in the same column as the Break
field. It will display the value of the Break field in any cell in the Break row.

The following figure illustrates the use of the number sign in a label in the
Break row:

This will produce a report sorted by Company, with each company’s products
listed alphabetically, and a summary showing the average price of each compa-
ny’s products, something like this:
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Adding Summary Calculations
You can add summary calculations on the contents of fields and formulas to

each Break row and to the Totals row.
The check boxes in the Cell area of the Quick Report editor identify the sum-

mary calculation options available for quick reports. The following summary cal-
culations are available:

• Sum totals the values in the report or break.
• Minimum displays the lowest value in the report or break.
• Maximum displays the highest value in the report or break.
• Average calculates the average of the values in the report or break.
• Count calculates the number of records in the report or break.
These options also appear in the Quick Report pop-up menu for cells in the

Break and Total rows.
When you place a summary calculation in the Totals row, the calculation is

done for all records in the report. If you place the summary calculation in a Break
row, separate calculations are done for the records in each break.

To add a summary calculation:
1 Select a cell in a Break row or in the Totals row where you want to insert

the summary calculation.
The Sum, Minimum, Maximum, and Average calculations work only on a

numeric field or formula.
2 Click as many summary calculation check boxes as you like.
Or
Hold down the mouse button and choose the desired summary calculations

from the Quick Report pop-up menu for cells.
CatBase displays a calculation icon in the selected cell for each type of sum-

mary calculation you request. The following figure shows calculation icons in the
Break and Total rows:
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If you add more than one summary calculation to a cell, CatBase stacks the
calculation icons on top of each other.

Displaying Repeated Values for Break Columns
In a report with breaks, the columns which are used to group records so that

summary calculations can be done are called Break columns. In the report shown
above, the Company Name field is a Break column since the records in the report
are grouped by company.

When a report like this is printed, the values for the Break column are printed
only once per break. In other words, a company name is printed only for the first
record in the group and is not repeated until the company changes.

In some cases, you may want to repeat the values for the Break columns so
that they appear for every record in the Break area. You do so by selecting the
Repeated Values column property. You can do so either by clicking the Repeated
Values check box in the Column Properties area or by choosing the Repeated
Values menu command in the Quick Reports pop-up menu for that column.

To display repeated values for fields in Break columns:
1 Select the Break column by clicking above the Header row for that column

and click the Repeated Values check box.
OR

Hold down the mouse button on the Header row of the Break column and
choose Repeated Values from the Quick Reports pop-up menu.

Setting Display Formats
You can specify display formats for columns that contain numeric or alphanu-

meric (Alpha) data. For example, if you are displaying prices in a column, you can
add a numeric format to the Detail cell for the Price field. If your report includes
Alpha fields such as a telephone number, you can use an Alpha format.

Alpha Formats
You can use an Alpha format for fields that contain string information.
For example,  telephone number fields can be formatted with an Alpha format

like this:

(####) ### ####

Numeric Formats
The following format places a pound sign to the left of the number and allows

up to 6 digits:
£###,###
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This format can display amounts up to £999,999. 
Following is detailed information about formatting  numbers.

Numeric formats
By default, numeric data are printed just as formatted in the database.

Sometimes you will want to change the number format. For example, you’ll prob-
ably want to display a monetary amount like this: £123.45. You have complete
control over numeric formats in the Quick Report Editor by using the formatting
symbols and rules explained here.

Numeric Formatting Symbols

Placeholders
Placeholders tell the Quick Report Editor how many digits to expect. There

are four numeric placeholders, each one with its own job to do. Table 1 shows
each placeholder and what it displays.

Placeholder Displays Displays for leading or trailing zero
# One digit Nothing
0 One digit A 0
^ One digit A space (see note below)
* One digit An asterisk

Table 1

Note: The caret (^) displays a non-breaking (hard) space character (ASCII
202) rather than a true space character (ASCII 20). This is because a non-
breaking space is the same width as a digit. It is created by typing Option-
spacebar (Mac) or Alt-spacebar (Windows).

You use one placeholder for each character that you expect to print. 
If you do not allocate sufficient placeholders, a number that is too big to fit

into your format will be printed as <<<. Remember to allow for negative numbers:
If a number is negative, the leftmost character displays as a minus sign (unless a
negative display format has been specified, as described below). So if you had
specified a format of #0 and the number was -44, there would not be enough
room for the number and it would be printed as <<<.

Decimal Point
One decimal point can be used in the format. If you want the decimal point to

be printed regardless of whether there is actually a decimal value, the decimal
point must be between zeros. For example, if the number to be printed is 44, it
will be printed as 44 if the format had been specified as ##.##, or as 44.00 if the
format had been specified as #0.00.

Other Characters
You can use any characters other than placeholders and the decimal point in

the format. If they are used alone, or placed either before or after placeholders,
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they always appear. If they are placed between placeholders, they appear only if
digits are printed on both sides. For example, if the format were £##0, a pound
sign would always appear because it is placed before all placeholders.

If the format were ###,##0, the comma would appear only if the number was
greater than 999.

Formats for Positive, Negative, and Zero
A number format can have three parts. The three parts allow you to specify

formats for positive, negative, and zero values. The three parts are separated by
semicolons:

Positive;Negative;Zero

If you use just one part, the format will be used for all numbers and a minus
sign will be placed in front of negative numbers. If you use two parts, the first
part is used for positive numbers and zero, and the second part is used for nega-
tive numbers. If you use three parts, the first part is used for positive numbers,
the second part is used for negative numbers, and the third for zero.

The following example prints pound signs and commas, places negative val-
ues in parentheses, and displays nothing for zero:

£###,##0.00;(£###,##0.00);

The presence of the second semicolon indicates that you want to use nothing
to print zero. If the second semicolon were missing, the positive number format
would be used to print zero.

Scientific Notation
To display numbers in scientific notation, use the ampersand (&) followed by a

number to specify the number of digits you want to display. For example, the for-
mat &3 would display 759.62 as 7.60e2.

The scientific notation format is the only format that will automatically round
the displayed number. 

Number Style Examples
Table 2 shows some examples of how different formats affect the printing of

numbers. The Positive column shows how 1234.50 would be printed; the
Negative column shows how -1234.50 would be printed. The Zero column shows
how a value of zero would be printed.

The tilde character (~) has been used to indicate an Option-space (also called
a hard space), and the <<< characters represent numbers too large for a given
format to display.
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Format Positive Negative Zero
### <<< <<<
#### 1234 <<<<
###### 1234 -1234
#####.## 1234.5 -1234.5
####0.00 1234.50 -1234.50 0.00
#####0 1234 -1234 0
+#####0;-#####0;0 +1234 -1234 0
#####0DB;#####0CR;0~ 1234DB 1234CR 0~
#####0~;(#####0) 1234~ (1234) 0~
###,##0 1,234 -1,234 0
##,##0.00 1,234.50 -1,234.50 0.00

^^^^^^^ ~~~1234 ~~-1234 ~~~~~~~
^^^^^^0 ~~~1234 ~~-1234 ~~~~~~0
^^^,^^0 ~~1,234 ~-1,234 ~~~~~~0
^^,^^0.00 ~1,234.50 -1,234.50 ~~~~~0.00

******* ***1234 **-1234 *******
******0 ***1234 **-1234 ******0
***,**0 **1,234 *-1,234 ******0
**,**0.00 *1,234.50 -1,234.50 *****0.00
£*,**0.00;-£*,**0.00 £1,234.50 -£1,234.50 £****0.00

£^^^^0 £~1234 £-1234 £~~~~0
~£^^^0;-£^^^0 ~£1234 -£1234 ~£~~~0
~£^^^0~;(£^^^0) ~£1234~ (£1234) ~£~~~0~
~£^,^^0.00~;(£^,^^0.00) ~£1,234.50 (£1,234.50) ~£~~~~0.00

&2 1.2e+3 -1.2e+3 0.0e+0
&5 1.23450e+3 -1.23450e+3 0.00000

Table 2

Entering the Display Format for a Field
You enter a display format or custom format by choosing it from the Quick

Report pop-up menu for the cell or by typing it into a cell.
To enter a display format for a numeric or Alpha field:
1 Click twice in the Detail cell for a numeric or Alpha column.
2 Type a display format
To choose a display format from the Quick Report pop-up menu:
1 Position the pointer over the Detail cell for a column and hold down the

mouse button and choose a display format from the hierarchical menu.
For example:
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The hierarchical menu will show display formats that are appropriate for the data
type of the column. For example, if the field was an alpha format, the menu com-
mand would be “Alpha” instead of “Numeric” and the submenu would list only
alpha formats.

After you make your selection, you can edit the format normally.
If you have also requested summary calculations for that column, the format

specified in the Detail cell will automatically be applied to the summary calcula-
tions. Regardless of the display format, the count is always displayed as an inte-
ger without formatting symbols such as the dollar sign.

Different formats can be applied to different columns in the report.

Hiding and Showing Rows and Columns
CatBase lets you hide rows or columns when printing a quick report. If

desired, you can show a hidden column or row.
Hiding rows is useful when you want the report to include only summary cal-

culations. For example, hide the Detail row if you want to display only the sum-
mary calculations that appear in the Totals and Break rows. You can also use this
feature to hide a Break row or the Totals row.

You can hide a column if you need to use the column as a sort column, but do
not want the report to display the column.

You can hide a row using either a Quick Report menu command or the Quick
Reports pop-up menu.

To hide a row using the menu command:
1 Select the row you want to hide.
2 Choose Hide from the Edit menu.
To hide a row using the pop-up menu:
1 Hold down the mouse button over the row label in the Row label bar.
The Quick Reports pop-up menu appears.
2 Choose Hide from the pop-up menu.
CatBase displays the column in grey to remind you that the row will not

appear when you print or preview the quick report.
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You can also use a menu command or the Quick Report pop-up menu to hide
a column.

To hide a column using the menu command:
1 Select the column you want to hide.
2 Choose Hide from the Edit menu.
To hide a column using the Quick Report pop-up menu:
1 Hold down the mouse button over the column header.
The Quick Reports pop-up menu appears.
2 Choose Hide from the pop-up menu.
CatBase displays the column in grey to remind you that it will not appear in

the printed report.

Showing a Hidden Row or Column
When a row or column is hidden, the Hide menu command in the Edit menu

and Quick Report pop-up menu becomes Show. You can display a hidden row
or column choosing Show from either the Edit or pop-up menu. When you do
so, the row or column is displayed normally in the Quick Report area.

Adding Page Headers and Footers
Before printing a quick report, you can add page headers and footers.
You specify page headers and footers in the Headers and Footers dialogue

box. Use this dialogue box to do the following:
• Add page header and footer text,
• Specify the size of the page header and footer areas,
• Specify fonts, font sizes, and font styles for page header and footer text,
• Insert codes that add page numbers and the date and time to your reports.
You can only specify page headers when printing to a printer. See the section

“Printing a Quick Report”  for more information about alternate output devices.

To add page headers and footers:
1 Choose Headers and Footers from the File menu.
The Headers and Footers dialogue box appears:
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The Headers and Footers dialogue box lets you specify both headers and
footers from the same screen. You use the Edit drop-down list to specify either
the header or footer.

2 Choose Header or Footer from the Edit menu.
3 Enter the header or footer height in the Height area.
When you first enter the dialog box, the header and footer heights are set to

25 points each. You can change values for the height and can change measure-
ment scale to enter values in inches or centimetres.

As you enter the header and footer height, the dotted lines on the page pre-
view area change to indicate the size of the header and footer as they will appear
on the printed report.

4 Select an entry area and type the header or footer text.
To the right of each entry area is a pop-up menu that lets you insert variables

into the entry area.

You can insert the current page number, time of printing, or date of printing.
To insert a variable, choose it from the pop-up menu. CatBase  inserts the

variable in the entry area at the insertion point. You can combine variables with
text.

Specifying Font Attributes
You can specify different fonts, font sizes, justification, and styles for page

headers and footers.
To specify font attributes:
• Choose a font and font size from the drop-down lists and click one or

more Style check boxes.
Your specifications are applied to all three entry areas. You cannot apply dif-

ferent font attributes to different areas of the header or footer.
Some Style combinations are not valid. For example, you can choose Bold

and Italic, but you cannot choose both Plain and Bold.

Printing a Quick Report
After you have completed your report design, you can print the quick report.

You can print a quick report to a variety of output devices:
• On the standard printer selected in the Print Manager (the Chooser on

Macintosh)
• To disk
• To a graph
To select an output device:
• Choose Print Destination from the File menu.
The Print Destination hierarchical menu contains three items.
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Printer 
This option uses the printer you have chosen in the Print Manager (Chooser

on Macintosh). You can print to a printer without using the Print Destination item
by choosing Print from the File menu. If you are printing to a printer, you can
preview the report before printing it.

To print to a printer:
1 Choose Print from the File menu.
2 Click the OK button and follow the standard procedure for previewing and

printing your report.
3 Choose the settings that are appropriate for your report and click the OK

button.

Disk File
This option sends your quick report to a disk file that you can open and modi-

fy with other applications, including text editors and spreadsheets.
This option exports the records in the quick report to a text file.
When you use this option, CatBase automatically uses the column headings

as the first “record” that is exported.
To print to a disk file:
1 Choose Disk File from the Print Destination hierarchical menu.
2 Choose Print from the File menu.
CatBase displays a standard create-file dialogue box and asks you to enter a

filename.
3 Enter a filename and click the OK button.
CatBase displays a dialogue box that keeps you informed of the progress of

the operation. Click the Stop Printing button to cancel the operation.
After the report is printed to a file, CatBase returns you to the Quick Report

editor. Remember to change the output device if you want to resume sending a
quick report to a standard printer.

Print to Graph
This option directs the report to 4D Chart, CatBase’s plug-in for plotting data.

When you choose the Graph item in the Print Destination hierarchical menu, your
report is presented as a graph rather than in tabular form. 4D Chart uses only the
summary calculations and labels in the Break row. It uses the leftmost non-
numeric column for the Values axis (the horizontal axis).

To use the Graph feature, your report should:
• Include from one to five numeric fields or formulas. These columns will be

assigned to the values axis in the graph.
• Use one type of summary calculation per numeric field.
For example, if you want to graph average product prices, you should create a
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quick report with two columns, Product Name and Price. Use the Average sum-
mary calculation for Price. For example:

To print to a graph:
1 Choose Graph from the Print Destination hierarchical menu.
2 Choose Print from the File menu.
CatBase graphs your data as a column graph.
The following figure shows the graph produced from the quick report design

shown above:
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You can use 4D Chart to select another graph type or print the graph.
For more information about the options available in 4D Chart, see the section

on Graphs later in this chapter.

Using Formulas in a Quick Report
Formulas can be added to Quick Reports; these can make it possible for you

to include data from other tables or perform various kinds of calculations on data
in the file on which the Quick Report is based.

The Formula Editor
The Formula editor provides many shortcuts for writing formulas. You can

click field names, operators, and routines to add them to the formula.
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The Formula editor contains the following areas:
• Editing area This area displays the formula as you build and edit it.
You create the formula in this area by either typing your function or selecting

operators, fields, and functions from the toolbar or panels at the bottom of the
editor. You can add a field to the Editing area by double-clicking or using drag
and drop.

• Operators toolbar The toolbar contains a row of buttons that you can use
to insert operators into a formula. The operators are shown in the follow-
ing illustration.

• Fields list: This area displays the names of fields in the selected table.
• Routines list: This area contains a list of drop-down menus or an alpha-

betical list of commands and user-written methods. Each drop-down
menu lists a group of 4th Dimension functions and commands. The
Routines list also displays the names of project methods and plug-in com-
mands. These methods appear at the end of the list of drop-down menus.

The pop-up menu above the Routines list controls whether the commands are
grouped by theme or listed alphabetically. Use this menu to control the display in
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the Routines area. You will need to be familiar with the 4Th Dimension program-
ming language in order to know how to use the Routines. We have included some
commonly used routines in the examples below. If you are using CatBase Multi-
user, you would have received a complete set of 4th Dimension documentation
with your 4D Server; this includes the Language Reference manual, which
describes all the Routines. Please contact CatBase Software if you need help
with this feature (send an email to support@catbase.com).

• Buttons area: This area contains buttons for saving your formula, loading
a saved formula from disk, cancelling an editing session, and applying the
formula.

You can build a formula by clicking operators and commands. You double-
click field names or add them to the editing area using drag and drop. When you
click an item, it automatically appears in the Editing area, where you can modify it
with standard cut, copy, and paste techniques. You can also type directly into the
Editing area.

A formula can be only one logical line long. You cannot press Enter and type
another line.

As you write the formula, the Formula editor performs basic syntax checking.
If it finds an error, it displays the error message above the Editing area.

Following are some example showing how you might use formulas.

Formula Example One: Converting Text to Uppercase
Suppose you want to display all the product names in uppercase, although

they are not stored in the database that way.
➢ Add a Product Name column to your Quick Report.
➢ Click in the Product Name column heading and choose Edit Column …

from the pop-up.
The Formula Editor opens up. 
➢ Click in the Product Name column heading and choose Edit Column …

from the pop-up. [Products]Product name is already set in the editing
area.

➢ Click in front of the [Products]Products name text in the editing area, and
type the text “uppercase(“ (without the quote marks!). Note the opening
parenthesis.

➢ Click at the end of the text and type in a closing parenthesis. 
The text should look like this:

Uppercase([Products]Product name)

If you press the Tab key on your keyboard, CatBase will check your formula to
make sure you’ve set it up correctly, and will alert you if anything is wrong. For
example, if you forgot to add the closing parenthesis, you would see a message
like this:
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➢ Click on OK.
When the report is printed, all product names will appear in uppercase.

Example 2: Getting data from another table
Using the Formula Editor you can find related information in another table and

use it in a report. Suppose, for example, we want to include the phone number
for the supplier of each product. We would need to locate the appropriate
Company record and then display its phone number. To do this:

➢ Make a list of the Product records you want to include in the report.
➢ Create a new Quick Report.
➢ Drag the Product Name field into the Quick Report editing area.
➢ Drag the Company Name field into the editing area.
➢ Click in the column heading of the Company Name column and choose

Insert Column from the pop-up.
The Formula editor appears.
➢ Create a formula like this:

QUERY([companies];[Companies]recordnumber=[Products]CompanyNumber)

➢ Click on OK.
The new column is called C1. 
➢ Click in the column header for C1 and choose Hide.
➢ Click to the right of the new column and insert another column.
➢ when the Formula editor appears, click in the pop-up menu above the list

of fields and choose All Tables.
The field list changes to a list of tables.
➢ Scroll down a little in the list of tables until you find Companies. Click on

the arrow (the plus sign on Windows) next to Companies. The list expands
to display all the fields in the Companies table.

➢ Double-click on the Phone field.
The editing area should look like this:

Note: The names of the tables and fields might be different in your copy of
CatBase.

➢ Click on OK.
➢ Click twice in the cell that is at the intersection of Column C2 and row H.
➢ Type in “Company Phone”
When you print the report, it will find each company’s phone number and print

it.
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Labels

CatBase’s Label editor provides a convenient way to print a wide variety of
labels.

With the Label editor, you can do the following:
• Design labels for mailings, file folders and file cards, and for many other

needs
• Specify the font, font size, and style to be used for the labels
• Specify the number of labels across and down on each page
• Specify the label page margins
• Load and save label designs
• Print labels

The Label Wizard
You use the Label Wizard to create, format, and print labels. The Label Wizard

contains settings for designing labels and positioning the labels on label paper.
For example, when producing mailing labels, you might want a label design that
includes the company’s name on the first line, the street address on the second
line, and so on.

As part of the design, the Label Wizard enables you to specify the number of
labels on the page and the margins of the label paper so that the label text is
centred within the labels.

The Label Wizard consists of two pages: the Label page and the Layout page,
each identified by a tab at the top of the dialogue box. You use the Label page to
specify the content of the label and the Layout page to define the size and posi-
tion of the labels on the page. When you create a satisfactory label design, you
can save it to disk so that you can reuse it.

Opening the Label Wizard
To open the Label Wizard:
1. Find the records for which you want to create labels.
2 Choose Labels from the File menu.
CatBase displays the Sort editor. Sort the records in the order you want them

printed.
CatBase then displays the Label page of the Label Wizard.

REPORTING AND COMMUNICATING

V. 4.17 5.31



Label Page 
The Label page contains settings for designing and formatting labels.
The Label page contains the following elements:
• Fields list: This area displays the names of the fields in the current table in

a hierarchical list.
• Label preview area: You use this area to design your label.
• Toolbar: The Label Wizard toolbar contains tools for drawing, selecting,

aligning, distributing, layering, and duplicating objects. For complete
information on the toolbar, see the section “The Label Wizard Toolbar”.

• Object Look area: These controls let you specify foreground and back-
ground colours, fill patterns, and borders for individual objects on the
label.

• Default Look button: This button applies the default set of Object Look
attributes to the selected object.

• Static Text entry area: This area allows you to add static text objects
to the label.

• Text attributes areas: These controls allow you to specify the font,
font size, display format, and style of the text.

• Form to Use drop-down list: This drop-down list lets you bypass the
Label Wizard and use a form to print the labels. If you are using the Label
Wizard to create the label, choose No Form (the default) from this list. If
you want to use a form, choose it from this list.
Note: This list displays all the forms that have been set up for the selected
table. Forms that have been designed specifically for printing labels have
names beginning with “Label”. You should not try to use any other forms
for printing labels -- you’ll get unpredictable and sometimes very bizarre
results. CatBase will then ignore any other label specifications in the Label
Wizard and print the labels according to the design or the specified form. 
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The Label Wizard Toolbar
The Label Wizard toolbar contains the following tools:

Creating a Label Design
You create a label by dragging field names to the Label Preview area, adding

static text, drawing graphic objects using the graphics tools in the toolbar, and
pasting graphics from the Clipboard. You can edit the label by distributing, mov-
ing, resizing, layering, and aligning objects.

With the Object Look and Text attribute areas, you can control the font attrib-
utes, foreground and background colours, fill patterns, and borders of individual
objects.

The Label Preview area shows the approximate size and shape of the select-
ed label. Before adding elements to the label, you may want to specify your label
paper and label dimensions using the Layout page.

For information, see the section “Specifying the Label Layout”.
To create a label:
1 Drag the first field you want to display in the label from the Fields list to

the Label Preview area.
Your field is added to the Label Preview area. Selection handles indicate that

it is selected:

2 If you want to concatenate a field to this field, drag the new field from the
Field list onto the existing field.

Otherwise, continue dragging fields to the Label Preview area.
A “+” between field names in a field object indicates that the fields are con-

catenated on a single line. When CatBase prints the label, it will insert a space
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between the fields on the same line. The following illustration shows the concate-
nation of the City and County fields:

As you add fields, you can reposition them by dragging or using the alignment
tools in the toolbar.

3 To add a text element to the label, enter the text in the Static Text area and
click the arrow.

The static text object is added to the Label Preview area. 
After you add the element to the label, you can reposition it by dragging and

aligning it with other objects.
4 (Optional) Using a drawing tool, draw any graphic objects that you want to

add to the label.
For example, you could add different backgrounds to the “TO:” and “FROM:”

sections of the label.
5 (Optional) Paste a graphic from the Clipboard into the Label Preview area.
For information on adding a graphic to the label, see the section “Adding a

Graphic to the Label”.
After you add all required elements to the Label Preview area, you can use

any of the editing tools to modify the label design. 

How the Label Wizard Handles Blank Fields
Some records in your database may not contain entries for every field. When

printing labels, the Label Wizard handles blank fields intelligently.
Instead of leaving gaps where the data should be, the Label Wizard concate-

nates the data.
If a field in a line contains no data for a particular record, the Label Wizard

concatenates the remaining fields in the line without leaving a blank space for the
missing data.

If an entire line contains no data for a particular record, the Label Wizard can
vertically concatenate the remaining lines in the label without leaving a blank line.
In order for this feature to work, you should add the fields in the following way:

As you click on a field in the field list, hold down the Shift key and keep hold-
ing it as you drop the field on top of the previous field. 

Holding the Shift key down tells the Label Wizard that you want to concate-
nate the field to the existing fields, but that it should go onto a new line.

In other words, if you concatenate a field onto an existing field without holding
down the Shift key as you do so, the field will be added to the same line as the
existing field, whereas if you hold the Shift key down as you drag the field, it will
start a new line if that field contains data.

The Label Wizard automatically centres the text of the label inside the label
area.

Clearing Fields
If you make a mistake, you can remove one or more fields from the label.
To remove an object:
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• Select the object and press Backspace (on Windows) or Delete (on
Macintosh).

The selected object is removed. If the object is a row of concatenated fields,
pressing Backspace removes only the last field in the row. Continue pressing
Backspace to remove more fields from the row.

Working with Label Wizard Objects
This section discusses the techniques for editing objects placed on the label.

It includes:
• Creating graphic objects,
• Aligning objects,
• Distributing objects,
• Layering objects,
• Duplicating objects,
• Moving objects,
• Resizing objects,
• Adding a border to an object,
• Adding foreground or background fill colours, patterns, and borders,
• Pasting a graphic into the label,
• Deleting objects.

Creating Graphic Objects
You can create a graphic object by drawing.
To create an object:
1 Select the type of object you want to draw by clicking its tool in the tool-

bar.
The pointer becomes a crosshair when it is over the Label Preview area.
2 Drag to create an area for the object.
For two-dimensional objects (ovals, rectangles, and rounded rectangles), drag

diagonally.
Note: Hold down the Shift key as you draw to constrain the object to a regular

shape. Lines are constrained to horizontal or vertical, rectangles are constrained
to squares, and ovals are constrained to circles.

3 When you have finished drawing the object, release the mouse button.
The Label Wizard creates the object and makes it the currently selected

object. The Arrow tool is automatically selected and the pointer becomes an
arrow.

Aligning Objects
The alignment tools let you align objects to each other. When you align one

object to another, you can align it to the top, bottom, side, or horizontal or verti-
cal centre of the other object.

The following illustration shows the Label Wizard’s alignment tools:
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The arrangement of lines represents the function of each tool. For example,
the Align Right icon shows the lines aligned vertically on the right side of the box.
The Align Centre Vertical icon shows the lines aligned vertically in the middle.

To align a set of objects:
1 Select the objects that you want to align.
Shift-click to select several objects.
2 Click the alignment tool that corresponds to the alignment you want.
The Label Wizard aligns the selected objects according to the alignment you

selected.

Distributing Objects
The toolbar includes two tools that let you distribute three or more objects

evenly.
Distribute vertically Distribute horizontally
When you use either tool, you can modify its action by holding down the Shift

or Alt keys when you click either tool.
• Clicking: Distributes the objects from their adjacent sides,
• Shift+Clicking: Distributes the objects from their left sides (horizontal) or

tops (vertical),
• Alt+Clicking: Distributes the objects from their right sides (horizontal) or

bottoms (vertical),
• Shift+Alt Clicking: Distributes the objects from their centres.
These rules are illustrated in the following diagram.
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To distribute a set of objects:
1 Select the objects that you want to distribute.
You must select at least three objects. Hold down Shift and click to select

several objects.
2 If desired, hold down a modification key or key combination and click the

Distribute Horizontally or Distribute Vertically tool.
The Label Wizard distributes the selected objects according to the rules you

selected.

Layering Objects
You may want to create a design that uses objects in different layers. For

example, you may want to place a shaded rectangle behind the fields on a label.
The Label Wizard provides the Move to Back and Move to Front, tools that let
you layer objects on the label. The following illustration shows objects in front of
other objects.

Clicking the Move to Front or Move to Back tools moves the selected objects
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to the top or bottom layer. If you want to move the object only one layer toward
the front or back, hold down the Shift key when you click Move to Front or Move
to Back.

To move an object to the front or back:
1 Select the object or objects that you want to move to the back.
Hold down Shift and click to select several objects.
2 Click the Move to Front or Move to Back tool in the toolbar.
The Label Wizard moves the selected object or objects to the front of or

behind all the other objects.
Note: When you move an object to the back, it may be hidden by objects in

front of it. To see the object, select the object in front and send it to the back.

Duplicating Objects
You can duplicate any object in the label. Copies of active objects retain all

the properties of the original, including foreground and background colours and
fill patterns, text attributes, and display format.

To duplicate an object:
1 Select one or more objects.
Hold down Shift and click to select several objects.
2 Click the Duplicate tool in the toolbar.
The Label Wizard duplicates the selected object or objects.

Moving Objects
You can move objects by selecting them and dragging with the mouse.
You can also use the arrow keys to move the object one or ten pixels at a

time.
• To move an object one pixel at a time, select the object and press an

arrow key.
• To move an object ten pixels at a time, select the object, hold down the

Ctrl key (on Windows) or Command key (on Macintosh), and press an
arrow key.

Resizing Objects
You can resize any object on the label by selecting it and dragging a selection

handle.
To resize an object by dragging:
1 Select the object you want to resize.
2 Move the pointer over one of the four handles that appear on the selected

object.
The pointer changes into a multi-directional arrow and the handles disappear.
3 Drag the handle toward the centre of the object to shrink it.
OR
Drag the handle away from the object’s centre to enlarge it.
The Label Wizard resizes the object.

Adding a Border to an Object
You can add a one-pixel border to an object. The border can be from one to

nine pixels from the object.
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To add a border:
1 Select the object.
The selected object is indicated by selection handles.
2 Hold down the Ctrl key (Command key on Macintosh) and press a number

from 1 to 9.
A border is added to the object. The distance from the object (in pixels) is

controlled by the number you pressed. 

Adding Foreground or Background Colours
The Label Wizard lets you add colours to objects for display on a colour moni-

tor or (if your printer supports colour) for colour printing. By combining selected
colours with fill patterns, you can display thousands of different colour shadings.

Note: Colours appear black and white on a black and white monitor. They
appear as shades of gray on a gray-scale monitor. The colour palettes display
shades on a gray scale monitor.

You can specify different colours for foreground pixels (pixels that appear
black on a black-and-white monitor) and background pixels (pixels that appear
white on a black-and-white monitor). If the object is a field or static text, the fore-
ground colour controls the colour of the text and the background colour controls
the colour of the object’s rectangle.

You set foreground and background colours using the Background and
Foreground picture menus in the Object Look area of the Label Wizard.

If your monitor supports 16 colours, choose the colours from the first 16
colours on each palette. If your monitor supports 256 colours (or more), any
colours you choose will display properly.

Setting Fill Patterns
You can apply a fill pattern to any two-dimensional graphic object in the form

such as an oval, a rectangle, a line, the enclosed area of a field or static text
object, and a two-dimensional object’s border.

The Fill picture menu controls the fill pattern for the selected object:

The Border picture menu controls the fill pattern for the border.

Setting Border Patterns
You can set patterns for the borders of any object in the form that has a bor-

der such as an oval, a rectangle, and a grid object. The border patterns available
are the same as the fill patterns. The appearance of the border also depends on
the line width you have specified for the border.

Setting Line Width
The Line Width pop-up menu controls the width of a line or the width of the

border of a two-dimensional object:
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To set a line width, select the object and choose a line width from the Line
Width pop-up menu.

Restoring the Default Look
When you add an object to the label, it takes on the Object Look attributes of

the most recently created object. If you want to assign the default Object Look
attributes to this object (or any object), select the object and click Default Look.
The foreground and background colours, fill patterns, and border width are reset
to the default settings.

Adding a Graphic to the Label
In addition to the drawing tools in the toolbar, you can paste a graphic from

the Clipboard into the label.
To paste a graphic into the label:
1 Place the graphic on the Clipboard by copying it from somewhere else

(your graphics program, for example).
2 Choose Paste from the Edit menu or press Ctrl+V (Command–V on

Macintosh).
The graphic appears in the Label Preview area with selection handles.
You can then move, align, distribute, or resize the object like any other object.

Deleting Objects
You can delete the selected object by pressing the Backspace key (Delete key

on Macintosh). If the selected object contains concatenated fields, the last field
is removed from the object. If you want to delete the entire object, continue
pressing the Backspace or Delete key.

Specifying the Label Layout
You specify the label layout with the Layout page of the Label Wizard.
You can display the Layout page at any time by clicking its tab.
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The Layout page contains the following elements:

Orientation and Labels Order buttons
These buttons enable you to specify the page orientation and the order in

which information is assigned to labels.

Labels across and down boxes
These boxes are used to control the size of labels by specifying the number of

labels that appear on your label paper.

Layout preview area
This area provides a reduced view of how an entire page of labels will look,

based on the dimensions you enter in the Label Wizard. The page preview also
reflects the paper size selected in the Print Setup dialog box. You can also select
the first label on the page to be printed. The red border indicates the size of the
physical page, and the blue border indicates the printable area.

Label Size and Page Size radio buttons
These buttons are used to select the label or the page for setting label and

page dimensions. If you click Label Size, you can enter the label width and label
height in the appropriate areas. If you click Page Size, you can enter values for
right margin and bottom margin.
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Margin boxes
These boxes are used to specify the dimensions of the label and the page

size, depending on the radio button you select. After you have entered the mar-
gins of your label paper, you may need to make some additional adjustments so
that the label text is centred in the labels. You can use both positive and negative
numbers in the Margin boxes to increase and decrease the margins.

Automatic Resizing
If Automatic Resizing is checked, the values in the Label Width and Label

Height entry areas are set automatically.

Horizontal Gap
This area controls the amount of space between label columns.

Vertical Gap
This area controls the amount of space between label rows.

Unit drop-down list
This drop-down list allows you to change the units in which you specify your

label and label page measurements. You can use pixels, millimetres, centimetres,
or inches.

Labels per record drop-down list
This control lets you print more than one copy of each label. If you print more

than one copy, the Label Wizard prints the copies consecutively rather than mak-
ing copies of the label pages.

Standard Code drop-down list
This feature is not currently implemented.

Method to apply
This feature is not implemented.

Apply Once radio buttons
This feature is not implemented.

File buttons
These buttons provide options for page setup, printing, saving, and loading

label designs.
To specify the layout of the label paper you are using:
1 Click the Layout page tab.
2 Click the Print Setup button.
The Print Setup dialogue box for your operating system appears.
3 Choose the desired printer and click OK.
If necessary, the Label Preview area changes to reflect your selection.
The remaining entry areas on the page change to reflect the selected label

paper’s characteristics. If necessary, you can modify these specifications.
4 Click the appropriate Orientation and Labels Order pictures.
You can choose between portrait and landscape orientation and horizontal or

vertical order.
5 Enter the number of labels in each row of your label sheet in the Labels

Across box and the number of labels in each column in the Labels Down
box.
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The Label Preview area adjusts to display the appearance of the labels on a
printed page.

6 If the first sheet of label paper is partially used, click on the first blank
label in the Label Preview area.

The Label Wizard will begin printing labels on the label you indicated.
The following illustration shows the Preview area after clicking on the second

label area.

7 If desired, choose a unit of measurement from the Unit drop-down list to
use for entering margin sizes.

8 Enter values to reflect the margins on your label paper.
Use the Label Size and Page Size radio buttons to control whether you use

the entry area for the size of the label or the size of the page.
The size of the individual labels in the label page preview will adjust to accom-

modate the margins. For example, if you increase the size of your margins to two
inches, top and bottom, the size of the individual labels will shrink to maintain the
same number of labels that you specified earlier.

Because some printers use portions of the margin to hold the label sheet in
place, the printer may not take the full margins into account when printing your
labels. In this case, you may need to adjust the margin settings so the label text
is properly centred in each label.

Since the printer uses part of the margins, the printer begins measuring the
margins from a point that is not precisely at the edge of the label paper. When the
labels are printed, the label text may appear skewed to the right or to the bottom
of the label paper.

To compensate for this lost margin space, you can use negative numbers in
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some of the margin boxes. When placed in the Right margin box, negative num-
bers pull the label text to the right. When entered in the Top margin box, negative
numbers pull the label text toward the top of the page.

Note: As a rule, using a negative number in a margin box moves the label text
toward the margin you are setting.

9 (Optional) If you want to print more than one copy of each label, use the
Labels per Record drop-down list to choose the number of copies to print.

The copies are printed consecutively on the label paper. The Label Wizard
does not duplicate the entire label page.

Saving and Loading Label Designs
CatBase lets you save each label design as a file that you can open from the

Label Wizard. By saving label designs, you can maintain a library of labels that
you can use according to your needs.

Saving a Label Design
To save a label design:
1 Click the Save button.
CatBase displays a dialogue box where you can enter a file name for the label

design.
Note: Label files on Windows are denoted by the file extension .4LB.
2 Enter a filename for the label design and click OK (on Macintosh, click the

Save button).

Loading a Label Design
You can load the label design whenever the Label Wizard is active.
To load a label design:
• Click the Load button.
CatBase displays an open-file dialogue box where you can select the filename

of a label design. Double-click the filename or select the filename and click OK.
(On Macintosh, choose a filename and click Open).

CatBase replaces the current label design with the design you selected.

Printing Labels
After you have completed your label design, you can preview or print the

labels. You may want to print first on regular paper so that you can check the
placement of text before you use the more expensive label paper.

To print your labels:
1 Click the Print button.
The Print dialog box appears for the printer you selected in the Print Manager

(or the Chooser, on Macintosh). If you check the Print Preview check box before
clicking OK, the labels are previewed to screen.

After the labels are printed, CatBase closes the Label Wizard and returns you
to your list of records.
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Quick Graph
CatBase allows you to create a wide variety of two- and three-dimensional

plots without having to export the data to a graphics package. You can create
graphs from the data in your database or from data that has been copied to the
Clipboard from another application.

You can graph data directly from fields or you can graph the results of calcu-
lations on data.

You can print your graphs or copy them to the Clipboard and paste them into
another application.

The Chart Wizard
The Chart Wizard is the dialogue box in which you create graphs. You choose

the graph type and specify the data to be graphed.
The Chart Wizard has three pages:
• Chart Type: Displays the types of charts supported by the Chart Wizard:

• Chart Styles: Displays the variations on the chart type selected in the
Chart Type page. The following illustration shows the styles available for
the 2D Column type:
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• Data Selection: Allows you to assign data to the chart axes. It displays the
appropriate options for the selected chart type. The following illustration
shows the Data Selection page for 2D Column charts.

You create a chart by choosing a chart type in the Chart Type page and
assigning data to the axes with the Data Selection page. Optionally, you may
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choose a chart style. If you do not make a selection from the Chart Style page, a
default style for the selected chart type will be used.

Quick Graph Terminology
Quick Graph can create either two-dimensional or three-dimensional plots.

For either type of plot, it refers to the horizontal (category) axis in the plot as the
X-axis and the vertical (values) axis as the Z-Axis. If a third dimension is included
in the plot, it is a second category axis and is referred to as the Y-axis. The sec-
ond category axis is sometimes called the series axis.

If you specify a two-dimensional chart type, the Data Selection page will have
two entry areas — for the X- and Z-axis fields. If you specify a three-dimensional
chart type, the Data Selection page will also have a Y-axis entry area in which you
specify the series.

Creating a Graph
To create a graph, first find the records that you want to include. 
1. Then choose Chart … from the FIle menu.
The Chart Type page of the Chart Wizard appears. Complete descriptions of

each chart type are included later in this chapter.
2. Click a chart type.
When you click on Chart Type, the Chart Style and Data Selection pages

change to match the requirements of the select type.
3. (Optional) Click the Chart Style tab.
The styles for the selected chart type appear.
4. (Optional) Click the desired chart style.
5. Click the Data Selection tab.
The Data Selection page appears, displaying the appropriate options for the

selected chart type. 
6. Make sure that the appropriate table is selected in the Source Table menu.
7. Drag the field that you want to assign to the Category axis to the Category

box or double-click it.
8. (Optional) Drag the Series field to the Y-axis (Series) box or double-click it.
The name of the field appears in the Y-axis (Series) box.
Note: If you make a mistake when choosing the X-axis or Y-axis fields, replace

the field by dragging the desired to field to Category or Series box.
9. Drag one or more fields or formulas to the Z-axis area or double-click it.
For instructions on creating a formula, see the section “The Formula Editor”.
Note: If you make a mistake when choosing a Z-axis field, click Delete to

remove it.
10. If you want to have the Z-axis values summed for each X-axis category,

click the Group check box.
This option is used when the X-axis categories are not unique and you want

each category to appear only once, with the values for each instance summed.
For more information about this option, see the section “Grouping Non-unique
Categories and Series”.

11 When you have finished designing your graph, click OK.
The Chart Wizard creates the graph and displays it in a window. The window

includes the standard Chart menus and tool palette. With these menu commands
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and tools, you can modify the chart.

Modifying the Graph
After you have created a graph, you can change its type or attributes.

Changing the Graph Type
After you have created a graph, you can plot the selected data using a differ-

ent chart type. Of course, you can only choose among the chart types that are
valid for the type of data that you are plotting. For example, if you are plotting
two-dimensional data, you cannot choose a three-dimensional graph type.

To change graph types:
Choose another graph type from the Graph drop-down list in the Chart Tool

palette.
OR
Choose another graph type from Chart Type item in the Chart menu.
OR
On Macintosh only, hold down the Control key and press the mouse button to

display a pop-up menu of graph types.
The graph is redrawn using the new graph type.
If you switch to a pie chart from a type of graph that displays more than one

Z-axis field, the Chart WIzard graphs only the first field assigned to the Z-axis.

Changing the Graph’s Attributes
You can modify a graph using any of the tools available in the Chart Wizard.
For example, you can:
• Resize a graph,
• Customise graph axes,
• Show and hide grid lines,
• Display the series values,
• Customise legends,
• Modify or remove depth in a two-dimensional graph,
• Change the perspective of a three-dimensional graph,
• Change the graphic attributes of chart objects,
• “Explode” a wedge from a pie chart,
• Add a picture to a picture chart.

Printing a Graph
After you are satisfied with your graph, you can print it by choosing Print …

from the Chart Wizard’s File menu. 

Copying a Graph
You can copy a graph to the Clipboard and paste it into a Picture field in

CatBase or into another application. To do this, choose Copy from the Edit
menu.

The graph is placed onto the Clipboard, and can then be pasted into another
application.

REPORTING AND COMMUNICATING

5.48 V. 4.17



Quick Letter
Quick Letter is an optional plug-in called 4DWrite which makes it possible for

you to send letters, emails, and faxes to companies or individuals in your data-
base. ( 

Note: Currently, the faxing feature is available only for
Macintosh).

With Quick Letter you can:

• Merge data from the Companies, Contacts or Products tables
• Add pictures
• Use the usual formatting options that you would expect to find in a word

processor

If you have purchased the 4DWrite plug-in, you will have received complete
documentation with it, so in this section we will just go over the basics.

To create a letter:
1. Create a list of the Companies, Contacts or Products to whom you want to

send a letter.
2. Choose Quick Letter … from the File menu.
A new Letter screen opens:

This window has its own menu bar:
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You create your letter just as you would write a letter using your usual word
processor. The big difference though, is that with Quick Letter you can merge
data from the database into your letters. Let’s suppose, for example, that you
want to send a letter to some companies that you have recently added to the
database to inform them of the information you’ve added so that they can check
it for accuracy.

3. Type the text of the letter, using the formatting options in the menu bar to
select the font, style, etc.

Inserting Data
4. To merge data from the database:

i. Choose Insert Field … from the Quick Letter Database menu. You’ll
see a dialogue like this:

ii. Select the appropriate table from the list of tables. The correct table to
choose is the one that your list of records comes from -- i.e., Companies,
Contacts, or Products (or whatever other names you may have assigned
to those tables). 

Choosing any other table will only give you bizarre results!

The list of fields will then change to show the fields from the selected table.
For example, if you chose Companies in the list of tables, your field list will then
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look something like this:

Note: In the current version of 4DWrite (6.0.5), the field names that are shown
are the original database field names, not the names that you may have selected.
Sorry about that. You may find it useful to have the Table and Field Setup window
open so that you can compare your field names against the original field names
(choose Table and Field Setup … from the Admin menu).

iii. Double-click on the field name you want to insert.
The field name is inserted into your letter, surrounded by special characters,

like this:

«[Companies]Company name»

(If yours doesn’t show the field name, choose Show References from the
Database menu in the Quick Letter menu bar.)

Inserting the Current Date
To automatically print the current date in your letters, choose Insert

Current Date from the Database menu.

Inserting the Current Time
To automatically print the time that each letter is printed, choose Insert

Current Time from the Database menu.

Inserting Pictures
To add a picture to your letter, copy it from your graphics program and paste it

into the letter.

You will find an example of a Quick letter in the Examples folder. (If you do not
have the Examples folder in your CatBase folder, you will find it on your original
CatBase CD). To open it, choose Open from the Quick Letter File menu, navigate
into the Examples folder, and double-click on Example Letter.
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Special Quick Letter Procedures
We have created some special procedures that you can include in your letters.

Each of these special “QL” procedures has a purpose, as described below:

Note that all of these procedures work only with the Companies table (i.e.,
your letter must be based on the Companies table). 

This list is current as of CatBase Version 4.17. From time to time we may add
more procedures, so please contact us if you need something that isn’t already
available – we may have already added it, or we may be able to add it for you.

To use a QL Procedure:
i. In your Quick Letter, choose Insert 4D Expression from the Database

menu. You will see a dialogue like this:

Description
Builds up a company address based on the Mailing
Address. If a field is empty, no blank lines or spaces
are included. Example:

50 The Maltings
Stanstead Abbotts, Herts SG12 8HG
UK

Builds up a company address based on the Street
address. The format is the same as the example
shown above for QL Address M.

Finds the Primary contact for each Company. If you
have designated more than one Primary contact,
which one it finds will be quite random! So you should
make sure that you always have only one Primary con-
tact selected for each Company. Example:

Ms. Pat Bensky, Managing Director

Creates a list of the company’s products and sorts
them alphabetically. Example:

Apple 20" Colorsync Display
Apple Multiple Scan  720 Display (17")
Apple Powerbook
LaserWriter 8500
Macintosh Server G3
Power Macintosh G3 Desktop

Procedure Name
QLAddressM

QLAddressS

QLPrimecontact

QLProductList
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ii. Type in the QL procedure name and click on OK.

Notes:
1. QL procedure names do not contain any spaces.
2. You must make sure that you type in the QL procedure name exactly as

shown in this document -- no extra spaces or other punctuation! Case is
not important, however.

4th Dimension Commands
If you are familiar with the 4th Dimension programming language, you can use

certain commands and functions in the same way as the QL procedures.
Following is a list of some that you may find useful:

Rounds a number to the specified number of decimal
places. The format is:

Round([table]fieldname;n)

Example:
Round([Products]price numeric;0)

Rounds the price to no decimal places.

Round

Converts data to all lower case. The format is:

Lowercase([table]fieldname)

Example:
Lowercase([Companies]company name)

Lowercase

Description
Converts data to all uppercase. The format is:

Uppercase([table]fieldname)

Examples:
Uppercase([Companies]company name)
Uppercase(QLAddressM) -- creates the mailing address and 

converts it all to uppercase

4D Command
Uppercase
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You can also do mathematical calculations on numeric fields. For example,
you can mark up or discount prices. Here are some examples:

Notes:
1. The table and field names you must use are the ORIGINAL database

names. If you have changed the table or  field names in your database,
you may find it helpful to have the Table and Field Setup window open
(Admin menu-> Table and Field Setup) so that you can see exactly
what the original field names are.

2. Table names are always surrounded by square brackets, as in:
[Companies].

Example:
[Products]price numeric*[Products]p4

(where the field P4 has been used to enter the quantity
ordered)
Calculates the total order price

Calculate a total

Example:
[Products]price numeric*.9

Discounts the price by 10%

Discount

Example:
[Products]price numeric*1.2

Marks the price up by 20%

Mark up

Returns the decimal part of a real number. The format
is:

Dec([table]fieldname)

Example:
Dec([Products]price numeric)

If the price is 12.90, the result is 90.

Dec

Returns the integer part of a real number. The format
is:

Int([table]fieldname)

Example:
Int([Products]price numeric)

The result is not rounded. If the price is 12.90, or if the
price is 12.25, the result is 12.

Int
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If you want to do some other type of processing and can’t figure out how to
do it, please contact our Technical Support Department and describe what you
want to do – we’ll be pleased to help.

Printing a Quick Letter
To print your Quick Letter, choose Print Merge … from the Quick Letter File

menu.
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Emails
You can easily send emails to companies or contacts in your database. To do

this you need to have:
1. A modem attached to your computer
2. An email account set up with a service provider

When you send emails, you can either use email addresses that have been
entered into the database for Companies or Contacts, or you can send an email
directly to an email address that you provide.

Setting up an Email Account
Before you can send any emails, you must set up at least one email account

record in your database. This contains the information that CatBase needs in
order to send the emails via your service provider. To do this:

1. Choose Email Accounts … from the Data menu and click on New
Record when the Search Dialogue window appears.

A new Email Account record opens:
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Email account name
This is the name by which you want this email account to be known in the

database. 
Macintosh users: If you have set up your Internet Config extension,

you can click on the Read from Internet Config button. CatBase
will complete the rest of the fields using your Internet Config data.

SMTP Host
Type in the name of your mail server. It usually looks something like: 

smtpmail.ispname.com.

Real Name
Type in your name as you want it to appear on your emails.

Organisation
Your company name.

From
Your actual email address.

When you have completed these fields, save the record.

Sending emails to Companies or Contacts
The first thing you must do, of course, is make sure that every Company or

contact to whom you want to send an email has a valid email address.
In the Companies table, there are four Internet fields. You can use any of

these fields for email addresses; just make sure that you use the same field in all
records. In the Contacts table, there is just one field designated as the Email
address field.

To send the emails:
1. Find the Company or Contact records that you want to send emails to.
2. With the list of records displayed, choose Send Email from the File

menu.
You will see a window listing all emails that have already been created.
3. Double-click on an email to open it, or click on the New button to create

a new one.
The email composition screen looks like this:
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Name
This can be any descriptive name for your email.

Send
You can send an email directly to an address that you type in, or you can send

the email to all of the selected records.

Single email
To send an email directly to one specific person, select the Single email

radio button and then type in the email address.

Bulk mail on database field
Select this radio button to send the email to all the selected records.
If you select this option, make sure that the appropriate field is selected in the

pop-up list of fields – i.e., make sure you’ve selected the field that contains the
email addresses!

Send via
This pop-up lists all the email accounts that have been set up in the database.

Select the one you want to use.

Subject
Type in a brief subject heading.

Now all that remains is for you to enter the text of the email into the text edit-
ing area.

When you are ready to send the emails:
1. Save it by clicking on the Save button.
2. To send the emails, click on the Send Now button.
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Sending Faxes
You can send bulk faxes to companies in your database. In order to

do this, you need:

1. A suitable modem attached to your Macintosh. It must be a Type 2
modem as that’s the only type that works with the fax software. (Please
contact CatBase Software if you are unsure about your modem.)

2. A copy of the FaxExpress software.
3. The 4DWrite word processing module installed.
Please contact us if you need to order any of these items! 

Note: If you are using CatBase Multi-User on a mixed network, it doesn’t mat-
ter whether the server is a Mac or PC as long as the workstation that you want to
use for sending the faxes is a Mac.

To set up and send faxes:
1. Make sure that all the Company records that you want to send a fax to

have a valid fax number entered into the Fax field.
2. Find the Companies to which you want to send a fax.
3. With a list of Company records displayed, choose Edit and Send Faxes

from the File menu.
You will see the normal Search Dialogue window. Either find the fax you want

to send, or create a new one.
The fax editing window looks like this:
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Note: If the text editing area on your screen doesn’t look like this, it is proba-
bly because you do not have the 4DWrite plug-in installed. 

Document Name
Type in a descriptive name for this fax.

Fax Number Replacing

In this area you can tell CatBase to change certain parts of a fax number.
Whether you use either or both of these options depends upon the format in
which you have entered the fax numbers in your database.

For example, in your database you may have set up the fax numbers in the
international format, like this:

+44 (0) 1920 877917

This is fine for publication, but when you actually send faxes to those fax
numbers, you need to make certain changes to the format of the numbers in
order for them to work.

There are two ways that you can change fax numbers: 
1. Remove your own country code, and/or
2. Replace the “+” part of the dialling code

Remove your national dialling code :
The national dialling code is the code for your own country, as specified in the

System Preferences window:

(Choose Setup from the Admin menu if you need to check or change this
setting.) 

If you select the Remove option, each occurrence of your own country code
will be removed from the fax number. For example:

If you have entered fax numbers in your database in this format:

+44 (0)1920 877917

you can select the Remove option, and when faxes are sent, the fax number
will be converted to:
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(0)1920 877917

(The brackets around the 0 won’t be removed but that doesn’t matter, as they
will be ignored).

Replace + with:

However, for faxes that are going to other countries, the number needs to be
changed in a different way. For example:

+ 33 (0) 123 4567

The “+” should be replaced with “00”. If the replacement string is different for
your country, you can change the default “00” to whatever is appropriate.

If this option is selected, any occurrence of “(0)” will also be removed form the
number.

For example:

+ 33 (0) 123 4567

will be changed to:

0033 123 4567
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Messages
If you are using the Multi-User version of CatBase, you can send messages to

other CatBase users.
To send a message:
1. Choose Send Message … from the File menu (Note: This choice is not

available if you are using CatBase Single-User).
You’ll see this dialogue window:

2. Select a User from the pop-up list. All Users except yourself are listed.
3. Type your message in the Message area.
4. Click the Accept button to send the message.

An example:
You have been speaking to the representative from one of the companies list-

ed in your database. She said that her company would be interested in placing a
display advertisement in your next edition, and you want to let the person who
handles advertising sales (Kate) know about this. You could quickly send a mes-
sage to Kate about this. Your message might look something like this:

If Kate is currently logged on to CatBase, she will immediately receive the
message. If the recipient is not currently logged on to CatBase, he/she will
receive the message as soon as they log on.
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